Coastal Campsite Monitoring Protocol- Kenai Fjords National Park

Christopher Monz, Utah State University

Available at: https://works.bepress.com/christopher_monz/84/
Coastal Campsite Monitoring Protocol

Kenai Fjords National Park

Christopher Monz
Utah State University
Department of Environment and Society
Logan, UT 84321

Fritz Klasner
National Park Service
Kenai Fjords National Park
Seward, AK

Kelly Goonan
Utah State University
Department of Environment and Society
Logan, UT 84321
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figures</td>
<td>iii</td>
</tr>
<tr>
<td>Tables</td>
<td>iv</td>
</tr>
<tr>
<td>Appendices and Standard Operating Procedures</td>
<td>v</td>
</tr>
<tr>
<td>Abstract</td>
<td>Error! Bookmark not defined.</td>
</tr>
<tr>
<td>Introduction</td>
<td>1</td>
</tr>
<tr>
<td>Purpose &amp; Goals</td>
<td>1</td>
</tr>
<tr>
<td>Scientific Background</td>
<td>1</td>
</tr>
<tr>
<td>Campsite Assessment Process</td>
<td>3</td>
</tr>
<tr>
<td>Assessment types</td>
<td>3</td>
</tr>
<tr>
<td>Sampling Design</td>
<td>4</td>
</tr>
<tr>
<td>Data Analysis and Summary</td>
<td>5</td>
</tr>
<tr>
<td>Field Procedures</td>
<td>8</td>
</tr>
<tr>
<td>Types of Assessments</td>
<td>8</td>
</tr>
<tr>
<td>Rapid Assessment</td>
<td>8</td>
</tr>
<tr>
<td>Full Assessment</td>
<td>8</td>
</tr>
<tr>
<td>Glossary</td>
<td>10</td>
</tr>
<tr>
<td>Literature Cited</td>
<td>11</td>
</tr>
</tbody>
</table>
Figures

Figure 1. Illustration of variable radial transect measurements. .................................................. 33

Figure 2. Illustration of geometric figure measurements. ............................................................... 34

Figure 3. Illustration of re-measurement using variable radial transect method. ...................... 35
## Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table 1. Condition class definitions</td>
<td>29</td>
</tr>
</tbody>
</table>
# Appendices and Standard Operating Procedures

<table>
<thead>
<tr>
<th>Appendix/Standard Operating Procedure</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appendix #1: Vegetation Cover On-Site</td>
<td>13</td>
</tr>
<tr>
<td>Appendix #2: Vegetation Cover Off-site</td>
<td>14</td>
</tr>
<tr>
<td>Appendix #3: Mineral Soil Exposure</td>
<td>15</td>
</tr>
<tr>
<td>Appendix #4: Campsite Condition Class</td>
<td>16</td>
</tr>
<tr>
<td>Appendix #5: Annual Planning &amp; Results Reports &amp; Maps</td>
<td>16</td>
</tr>
<tr>
<td>Standard Operating Procedure (SOP) #1: Staff Training</td>
<td>21</td>
</tr>
<tr>
<td>Standard Operating Procedure (SOP) #2: Materials for Collecting Field Data</td>
<td>22</td>
</tr>
<tr>
<td>Standard Operating Procedure (SOP) #3: Full Assessments</td>
<td>24</td>
</tr>
<tr>
<td>Standard Operating Procedure (SOP) #4: Rapid Assessments</td>
<td>36</td>
</tr>
<tr>
<td>Standard Operating Procedure (SOP) #5: Electronic Workspace Management</td>
<td>37</td>
</tr>
<tr>
<td>Standard Operating Procedure: GPS and Camera Setup</td>
<td>40</td>
</tr>
<tr>
<td>Standard Operating Procedure: Collecting GPS and Photo Data</td>
<td>45</td>
</tr>
<tr>
<td>Standard Operating Procedure (SOP): Data Management</td>
<td>55</td>
</tr>
<tr>
<td>Standard Operating Procedure (SOP): Photo Management</td>
<td>63</td>
</tr>
</tbody>
</table>
This manual describes all procedures necessary to conduct initial and repeat campsite assessments in coastal areas of Kenai Fjords National Park.

NPS managers can use past, current and future data in the following manner:

- Document current impacts and condition of campsites.
- Use in the development of and decision making in a Limits of Acceptable Change (LAC), Visitor Experience and Resource Protection (VERP) or similar indicators and standards planning process.
- Develop minimum impact suggestions for Park visitors.
- Evaluate the success of management actions to minimize visitor created resource impacts in coastal areas
- Assist in the determination of sustainable visitor capacities for coastal areas of Kenai Fjords National Park.
- Create boundaries for various use zones.

This manual should be updated at regular intervals based on knowledge gained during field assessments. These updates will reflect a continued improvement of the best monitoring practices.
Introduction

Purpose & Goals

This campsite inventory and monitoring program is designed to measure backcountry campsite conditions in coastal areas of Kenai Fjords National Park (KEFJ).

Specific objectives for the inventory and monitoring program are as follows:

• Provide initial recreational campsite condition information in a format conducive to the formation and the evaluation of decisions regarding the management of backcountry camping resources

• Provide cumulative and ongoing campsite information that monitors changes in campsite condition over time

Key questions that will be answered by an ongoing program of monitoring are as follows:

1. Where are the existing campsites in coastal areas of Kenai Fjords?
2. What is the level of resource impact occurring at each campsite?
3. How are the campsite conditions and locations changing over time?
4. Is the number of campsites within Kenai Fjords changing over time?

Scientific Background

The demand for wildland recreation and nature-based tourism opportunities continues to increase in many protected areas in North America (Cordell 2008) and worldwide (De Lacy and Whitmore 2006). In Kenai Fjords National Park, with some annual variation, use has remained at high levels for over fifteen years, with the greatest number of visitors arriving in 1997 (306,000) and the second and fourth highest years being 2007 and 2008 respectively. When use increases and demand remains high, there is an associated potential for human disturbance and change to the environmental conditions of protected areas. Under these conditions minimizing undesirable resource impact is often a high priority for management. Understanding the conditions of resources through ongoing assessment and monitoring is essential for many aspects of sound adaptive management, particularly in determining the effectiveness of management actions in achieving resource protection goals.

Given the aforementioned trends, a common concern among managers of protected areas is resource change due to backcountry camping. Backcountry camping activities have the potential to affect resource conditions at the individual site and larger spatial scales due to site expansion and proliferation (Leung and Marion 1999, Twardock et al., 2010). Campsites are important because they as they serve as destinations and focal points for visitor activities, and as such campsite condition and quality greatly affects the visitors’ experience. Ecologically, campsite are
locations of concentrated use and notes of localized and intense disturbance, particularly of soil
and vegetation characteristics. Numerous studies of campsites in parks and protected areas have
examined the degree to which visitor use can affect change on site conditions (e.g., Frissell 1978,
Cole, 1983) with some studies involving repeated examination of the trends of change over time

Managers find campsite assessment studies useful as they often seek to minimize undesirable
resource impacts and the associated aesthetic degradation of sites to maintain high quality
wildland experiences for visitors. Although less common, other types of campsite studies have
used experimental designs to examine functional relationships such as use-impact relationship
(Hammitt and Cole 1998) and spatial patterns of impact (Cole and Monz 2004). Several
generalizations about campsite condition trends can be drawn from this literature. First, over
time on established sites, changes in the number and areal extent of impact tend to be more
pronounced than changes in intensity of impact. For example, Cole and Hall (1992) studied
campsites over an 11-year period in the Eagle Cap Wilderness in Oregon and found campsite
size increased substantially but mean vegetation cover was relatively stable. Similar results were
found over a 20-year period in Grand Canyon National Park (Cole et al. 2008). Second,
aggregate impact (increased number of sites and total area of disturbance) tends to increase over
time and may be more of a management concern than the level of degradation at individual sites.
Cole’s (1993) assessment of three wilderness areas in the western U.S. found that over a 12-14
year period, the total number of sites increased substantially in each area, but degraded in
resource condition in only one area. Finally, assessment studies suggest and experimental studies
confirm that on a given site, most impact occurs at low use levels and subsequent increases in
use do not result in proportional increases in impact (Leung and Marion 2000, Cole and Monz
2004, Cole et al. 2008). Overall, these findings support the importance of campsite assessment
studies in informing management actions to maintain the quality of resource conditions.

Research has also been conducted to evaluate the effectiveness of both at-large and confinement
camping management strategies in wildlands. Confinement seeks to limit the number and size of
campsites. Typically, visitors are encouraged to camp on designated sites or in areas where
 campsites have previously been established and to concentrate traffic in the core areas of sites.
Alternatively, at-large camping allows the visitor to select places to camp in accord with overall
regulations, such as distance to water. Several studies have assessed the effectiveness of
confine strategy with somewhat contrasting results. One conclusion, based on research
conducted in the eastern United States, has found confinement to be effective at limiting the
formation of new sites and reducing existing site numbers to a few well maintained, desirable
sites (Marion 1995, Marion and Farrell 2002, Reid and Marion 2004). This rationale is a well-
accepted practice in some parks and wilderness areas, particularly in locations where visitor use
pressure is high (Leung and Marion 2000) and is central to current best practices for minimum
impact camping (Hampton and Cole 2003). In contrast, Cole et al. (2008) in a 20-year period in
Grand Canyon National Park, found more new site formation in areas under a confinement
strategy than in areas that encouraged at-large use. While they provide some speculation as to the
cause of this phenomenon, overall these results demonstrate the challenges of minimizing site
proliferation, even while employing strategies shown to be effective elsewhere.

Campsite studies in Alaska are more rare, but results from a long term study of campsite
condition trends (Twardock et al., 2010) and monitoring protocols (Monz and Twardock 2010)
in Prince William Sound (PWS) have implications for management strategies and monitoring protocols. These studies are particularly germane to KEFJ given the geographic proximity and the similarities in vegetation, topography and visitor activity types.

For example, the analysis of trends of campsite condition over a thirteen year period in PWS (Twardock et al., 2010) showed that impacts such as multiple trailing, tree and shrub damage and large sites were prevalent. The intensity and extent of impact varied by environment type, with campsites on soil substrates in upland forests exhibiting less vegetation cover loss, mineral soil exposure and total area of impact than campsites found on cobble substrates with beach grass vegetation. Comparative analyses of resource conditions over time indicated increases in areal extent of impact, including the development of new sites, but decreases in impact intensity. Overall it was concluded that over the long term in PWS, the at-large camping strategy may not be effective at containing site spread and proliferation, impacts managers often considered the most important to limit.

**Campsite Assessment Process**

**Assessment types**

Two types of overall campsite assessment strategies were developed for the long term monitoring strategy in KEFJ. A **Rapid Assessment** protocol was developed so park staff could collect usable data during situations when opportunistic inspection of campsites was possible. For example, if resource management staff were in the field in remote areas of the Park for other purposes, the rapid assessment protocol could be used to assess known sites for major changes in conditions and/or to search areas for the development of new or heretofore unknown sites. Information gathered is particularly informative to the **Complete Assessment** as it highlights new areas that should be measured, and existing locations that are changing and in need of re-measurement. The rapid assessment protocol takes approximately 5 minutes per campsite and can be performed during field seasons that fall in between regular monitoring intervals for the complete assessment.

The **Complete Multi Parameter Assessment** is a state of the art campsite monitoring protocol specifically developed for coastal Alaska. The protocol requires dedicated time from park staff, and logistical support (KEFJ Research Vessel Serac) in order to be performed efficiently. Initial protocol development and campsite assessments required approximately seven days and five staff. The complete assessment uses high accuracy GPS positioning, electronic attribute data collection, and integrated photo monitoring to speed field time and subsequent data analysis. Depending on the complexity of the site the Complete Assessment can require 15-30 minutes of time by 2-3 field staff.
**Sampling Design**

The following is a suggested sampling design for KEFJ regions for both the Rapid Assessment and Complete Assessments.

**Table X.** The suggested sampling interval and monitoring approach for KEFJ coastal regions.

<table>
<thead>
<tr>
<th>KEFJ Region</th>
<th>Year 1</th>
<th>Year 2</th>
<th>Year 3</th>
<th>Year 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aialik</td>
<td>C</td>
<td>N</td>
<td>R</td>
<td>R</td>
</tr>
<tr>
<td>Northwestern</td>
<td>R</td>
<td>C</td>
<td>N</td>
<td>R</td>
</tr>
<tr>
<td>Nuka</td>
<td>N</td>
<td>R</td>
<td>C</td>
<td>N</td>
</tr>
<tr>
<td>Outer Coast</td>
<td>N</td>
<td>R</td>
<td>C</td>
<td>N</td>
</tr>
<tr>
<td>Resurrection</td>
<td>R</td>
<td>N</td>
<td>R</td>
<td>C</td>
</tr>
</tbody>
</table>

C= Complete; R=Rapid; N= No monitoring
Data Analysis and Summary

The following tables summarize the data collected during the 2010 complete assessment and provide a suggested analysis and reporting strategy.

Table 1  Summary of current (2010) campsite conditions in Kenai Fjords National Park. Values are means ± SD for continuous measures and medians ± range for ordinal measures.

<table>
<thead>
<tr>
<th>Site Attribute</th>
<th>KEFJ Study Area¹</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Continuous Measures</strong></td>
<td></td>
</tr>
<tr>
<td>Area of observable impact (m²)</td>
<td>28.27 ± 30.31</td>
</tr>
<tr>
<td>Condition class</td>
<td>2.4 ± 1.0</td>
</tr>
<tr>
<td>Fire sites (#)</td>
<td>0.11 ± 0.35</td>
</tr>
<tr>
<td>Informal trails (#)</td>
<td>2.27 ± 1.32</td>
</tr>
<tr>
<td>Mineral soil exposure (%)</td>
<td>59.8 ± 37.2</td>
</tr>
<tr>
<td>Stumps/cut shrubs (#)</td>
<td>0.11 ± 0.5</td>
</tr>
<tr>
<td>Ghost stumps (#)</td>
<td>0.21 ± 0.89</td>
</tr>
<tr>
<td>Vegetation cover loss (%)</td>
<td>55.7 ± 39.5</td>
</tr>
<tr>
<td><strong>Ordinal Measures</strong></td>
<td></td>
</tr>
<tr>
<td>Human waste</td>
<td>1 ± 0</td>
</tr>
<tr>
<td>Litter/trash</td>
<td>1 ± 2</td>
</tr>
<tr>
<td>Root exposure</td>
<td>1 ± 2</td>
</tr>
<tr>
<td>Tree damage</td>
<td>1 ± 1</td>
</tr>
<tr>
<td>Ghost tree damage</td>
<td>1 ± 2</td>
</tr>
</tbody>
</table>

¹ N= 81
Table 2. Frequency of impact problems at campsites in Kenai Fjords National Park in 2010. Values are the percentage of sites that demonstrate the indicated impact parameter and severity.

<table>
<thead>
<tr>
<th>Impact Parameter</th>
<th>Frequency</th>
<th>Percent</th>
</tr>
</thead>
<tbody>
<tr>
<td>≥ moderate tree/shrub damage</td>
<td>13</td>
<td>16.0</td>
</tr>
<tr>
<td>≥ moderate ghost tree damage</td>
<td>6</td>
<td>7.4</td>
</tr>
<tr>
<td>≥ moderate root exposure</td>
<td>12</td>
<td>14.8</td>
</tr>
<tr>
<td>Presence of cut tree stumps/ cut shrubs</td>
<td>4</td>
<td>4.9</td>
</tr>
<tr>
<td>Presence of cut ghost tree stumps</td>
<td>6</td>
<td>7.4</td>
</tr>
<tr>
<td>Multiple trailing</td>
<td>59</td>
<td>72.8</td>
</tr>
<tr>
<td>Fire impacts present</td>
<td>8</td>
<td>9.9</td>
</tr>
<tr>
<td>Significant presence of camping trash</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Observable human waste</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Campsites larger than 50 m²</td>
<td>5</td>
<td>6.2</td>
</tr>
</tbody>
</table>

N = 81

Table 3. A comparison of selected resource condition parameters on KEFJ campsites in 2010 on differing substrate types.

<table>
<thead>
<tr>
<th>Impact Parameter</th>
<th>Substrate Type¹</th>
<th>ANOVA Results</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Organic Soil</td>
<td>Cobble</td>
</tr>
<tr>
<td>Vegetation Cover Loss (%)</td>
<td>32.6</td>
<td>69.5</td>
</tr>
<tr>
<td>Condition Class</td>
<td>2.08</td>
<td>2.55</td>
</tr>
<tr>
<td>Mineral Soil Exposure (%)</td>
<td>3.6ᵃᵇ</td>
<td>79.1ᵃᶜ</td>
</tr>
<tr>
<td>Area of observable impact (m²)</td>
<td>21.6</td>
<td>27.1</td>
</tr>
</tbody>
</table>

¹ Values are means. Means followed by the same letter are significantly different with Scheffe’s multiple comparison test at P ≤ .05, DF=2.
Table 4 Summary of current (2010) campsite conditions in Kenai Fjords National Park by landing beach. Values for vegetation cover loss and condition class are means ± SD. Values for total area of impact and total area of vegetation loss are sums for each camping area.

<table>
<thead>
<tr>
<th>Beach Name</th>
<th>Vegetation Cover Loss (%)</th>
<th>Condition Class</th>
<th>Total Area of Impact (m²)</th>
<th>Total Area of Vegetation Loss (m²)</th>
<th>Number of Sites</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abra</td>
<td>70.3 ± 21.2</td>
<td>3.2 ± 0.8</td>
<td>85.39</td>
<td>61.17</td>
<td>5</td>
</tr>
<tr>
<td>ABRS North</td>
<td>97.1</td>
<td>4</td>
<td>47.36</td>
<td>45.98</td>
<td>1</td>
</tr>
<tr>
<td>Bear Cove</td>
<td>56.6 ± 34.8</td>
<td>3.17 ± 1.2</td>
<td>227.08</td>
<td>145.66</td>
<td>6</td>
</tr>
<tr>
<td>Bulldog</td>
<td>15.2 ± 95.8</td>
<td>2.2 ± 1.6</td>
<td>133.0</td>
<td>70.16</td>
<td>5</td>
</tr>
<tr>
<td>Holgate</td>
<td>50.2 ± 27.3</td>
<td>1.8 ± 1.1</td>
<td>176.72</td>
<td>93.89</td>
<td>9</td>
</tr>
<tr>
<td>McMullen</td>
<td>50.2 ± 27.3</td>
<td>1.7 ± 0.6</td>
<td>53.48</td>
<td>44.42</td>
<td>3</td>
</tr>
<tr>
<td>Northeastern</td>
<td>48.2 ± 33.0</td>
<td>2.8 ± 0.4</td>
<td>441.49</td>
<td>188.01</td>
<td>9</td>
</tr>
<tr>
<td>Northwestern</td>
<td>52.5 ± 42.9</td>
<td>2.4 ± 0.5</td>
<td>151.51</td>
<td>73.47</td>
<td>9</td>
</tr>
<tr>
<td>Pederson</td>
<td>38.5 ± 31.6</td>
<td>2.3 ± 1.2</td>
<td>215.14</td>
<td>104.05</td>
<td>12</td>
</tr>
<tr>
<td>Quicksand</td>
<td>73.1 ± 17.8</td>
<td>2.4 ± 0.7</td>
<td>280.12</td>
<td>209.17</td>
<td>12</td>
</tr>
<tr>
<td>Sunlight</td>
<td>50.9 ± 47.3</td>
<td>1.0 ± 0</td>
<td>69.02</td>
<td>53.31</td>
<td>3</td>
</tr>
<tr>
<td>Verdant</td>
<td>88.1 ± 5.9</td>
<td>2.6 ± 0.5</td>
<td>217.98</td>
<td>192.17</td>
<td>7</td>
</tr>
</tbody>
</table>

N = 81
Field Procedures

This protocol describes procedures for conducting inventories and resource condition assessments necessary to document changes in the condition of primitive campsites in Kenai Fjords National Park. Three general approaches are used for assessing campsite conditions:

1. Photographs should be taken from permanently referenced photographic vantage point(s).
2. Condition class assessment is determined by visual comparison with six described levels of campsite impact.
3. This is both a measurement-based and ratings-based multiple indicator assessment of campsite conditions.

Types of Assessments

Rapid Assessment

Full Assessment

Survey Area: For areas surveyed and no sites found, collect a line feature with the Trimble GPS to denote the lineal extent of the beach surveyed.

Trails: When trails are evident collect a line feature with the Trimble GPS to denote the route and characteristics as defined in the data dictionary.

Campsites: For the purposes of this manual, campsites are defined as backcountry areas of disturbed vegetation, surface litter, and/or soils caused by overnight camping activities. Remember, vegetation disturbance/loss is the key indicator used to identify visitor sites. Fire sites, where other resource impacts are not present, are classified under “other visitor sites”.

Finding sites: A goal of the inventory/monitoring program is to keep informed of campsite conditions in Kenai Fjords National Park. To achieve this goal, new visitor sites are added to the inventory as they are discovered. Surveyed areas must be thoroughly searched to identify the locations of visitor sites to add to the program and to locate previously surveyed campsites—including those no longer used. After landing on a beach with potential camping, conduct searches for new visitor sites by following all informal trails, however faint, to search out likely camping areas. Analyze visitor sites vegetation by comparing site to adjacent areas of similar topography—compare a disturbed beach berm with a similar undisturbed beach berm. For coastal visitor sites (those along or near beaches), be sure to analyze the site for natural influences, such as tidal and weather, to determine whether the vegetation inconsistencies are due to human or environmental influence.

Recovered sites: Sites in the inventory can change over time. If a campsite is no longer used and vegetation recovery is such that campsite boundaries can no longer be identified—a condition
class 0— fill out complete protocol, and record a zero when relevant. Do not leave anything blank. A blank record means it was not recorded.

_Tent Rock Sites:_ Use best judgment to find center point, take GPS point data. Fill out complete protocol, record zero when relevant, N/A when not applicable, and don’t leave anything blank. Blank means it was not recorded.

_For a new campsite to be valid, the following information is required:_
- Completion of inventory form in its **entirety**
- Burial of a permanent center point marker
- Radial transect data of the campsite

_Campsite re-measurement:_ Due to campsite use and vegetative changes occurring over the use season, it is critical that the campsites are re-measured within one to two weeks of the initial assessment day.

**Photopoints:** Photo point monitoring is conducted at locations where site boundaries are indeterminate, such as a beach with vegetation loss and disturbance, but no clear sites forming.

**Other Visitor Sites:** Record the following as point features on the Trimble GPS
- Fire Site- no other resource impacts present
- Tent Rock sites
- Beach Furniture

_Generic Features:_ Whenever possible and appropriate, the above assessment types should be used. Generic point, line, and area features can however also be documented.
Glossary

aspect: The general compass heading (± 15 degrees) that describes the orientation of the beach. In other words which way the beach "faces".

azimuth: The compass heading or "bearing". A magnetic azimuth is used in the radial transect method.

bedrock: shelf bedrock

campsite: Backcountry areas of disturbed vegetation, surface litter, or soils caused by human use such as overnight camping activities.

cobble: Fist sized rocks, larger than gravel, that do not move when you walk on them.

gravel: Small rocks of maximum size of 1-2 cm. If it moves when you walk on it, it's gravel.

mineral soil: Soil devoid of the obvious organic layer, and by general observation to consist only of mineral components, i.e., sand, silt and clay.

organic liter: A layer of dead and decaying plant material on the surface of the soil

sand: Includes sandy beach soils that do not form a surface crust in trampled areas.

soil: Includes clays to loamy soils. Soil is a mixture of minerals, organic matter (dead and alive), water and air. (Note: moss is a vegetation NOT soil)

substrate: A general term used to describe the soil-vegetation types where campsites are found.

trash: All recreation litter that is seen when standing at the center point of the campsite, flotsam is not included.

vegetation: The kinds of plants or plant communities where campsites are found.
Literature Cited


Appendix #1: Vegetation Cover On-Site

0-5% cover

6-25% cover

25-50% cover

51-75% cover

76-95% cover

96-100% cover
Appendix #2: Vegetation Cover Off-site

0-5% cover

6-25% cover

25-50% cover

51-75% cover

76-95% cover

96-100% cover
Appendix #3: Mineral Soil Exposure

0-5% cover

6-25% cover

25-50% cover

51-75% cover

76-95% cover

96-100% cover
Appendix #4: Campsite Condition Class

Appendix #5: Annual Planning & Results Reports & Maps
2007 Rapid Assessment Planning & Results

2007 Rapid Campsite Assessment

Legend
- No visitor impacts observed

Campsite
- Condition Class 1
- Condition Class 2
- Condition Class 3

2007 Results
2008 Campsite Assessment Planning & Results

Annual Report

Campsite Assessment - 2008 Data Collected

Kenai Fjords National Park

Easements

Estate_Type

ANCSA 17a Site Easement
ANCSA 17a Trail Easement

Park Boundary

ANSLCA: Public Law 96-487

2008 results
2009 Campsite Assessment Planning & Results

2009 Planning

Campsite Assessment - 2009 Data Collected

2009 Results
2010 Campsite Assessment Planning & Results

All established sites

Example detail map
Standard Operating Procedure (SOP) #1: Staff Training

Version 1.0

Change History

Version numbers will be incremented by a whole number (e.g. Version 1.3 to Version 2.0) when a change is made that significantly affects requirements or procedures. Version numbers will be incremented by decimals (e.g. Version 1.6 to Version 1.7) when there are minor modifications that do not affect requirements or procedures.

The following revisions have occurred to this plan since Month Year

<table>
<thead>
<tr>
<th>Version #</th>
<th>Date</th>
<th>Revised by</th>
<th>Changes</th>
<th>Justification</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This Standard Operating Procedure (SOP) explains the requirements for staff training involved in conducting data collection or analysis. Although this manual contains all the information necessary to conduct the inventory and monitoring program, it is not meant to be a substitute for proper on-site staff training. The objective of staff training is to communicate and illustrate field procedures, develop and refine experience and judgment, and build a commitment to quality. A minimum of two days of staff training is recommended. Training can be organized as outlined below:


Day 2: For Quality Control, assessment procedures are demonstrated on a typical campsite. Following discussion and question and answer session, field staff, independently or in small groups, will apply procedures to a common group of campsites. The entire group reviews evaluations of each campsite. Differences are examined and resolved by referring to the manual and group critique.

A minimum of two field personnel are needed to conduct the inventory.
Standard Operating Procedure (SOP) #2: Materials for Collecting Field Data

Version 1.0

Change History

Version numbers will be incremented by a whole number (e.g. Version 1.3 to Version 2.0) when a change is made that significantly affects requirements or procedures. Version numbers will be incremented by decimals (e.g. Version 1.6 to Version 1.7) when there are minor modifications that do not affect requirements or procedures.

The following revisions have occurred to this plan since Month Year

<table>
<thead>
<tr>
<th>Version #</th>
<th>Date</th>
<th>Revised by</th>
<th>Changes</th>
<th>Justification</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This Standard Operating Procedure (SOP) identifies needed field equipment.

- Kenai Fjords topographic maps.
- Kenai Fjords National Park Coastal Campsite Monitoring Manual—one per person.
- Sighting compass.
- Tape measure—30 meters in tenths.
- Flagged wire pins—25 minimum (two separate colors if more than one group working.
- Digital Camera.
- Monopod for sighting compass and digital camera.
- Aluminum numbered tags, galvanized steel bolts at least six inches in length (the larger the head the better for ease of finding the bolts in the future), nylon wire ties to connect the tags to the bolts. Make sure that the bolts can be found by the magnetic pin locator.
- One clipboard, waterproof paper, waterproof pens, and mechanical pencils with erasers.
- Sonin Combo Pro distance measuring device with spare AA batteries.
- Trimble GeoXT, Hurricane Antenna, Range Pole, Mounting Bracket, Stylus.
• Data Dictionary: KEFJ_CampInv_vXX, updated for each season

• Re-measurement materials: Original assessment data file loaded on to the Trimble GPS for re-navigation purposes and photographs from previous campsite surveys. It is very important to bring these into the field. Do not attempt to re-measure a campsite without the original data sheets and photographs.

• Magnetic pin locator with spare battery. The magnetic pin locator is a key piece of equipment used to find previous bolts during the re-measurement process.

Use of Sighting Compasses (Suunto or Brunton): Hold the compass level with the viewfinder close to your eye and away from any metal objects. The top of the white floating scale should be centered in the viewfinder. Hold the compass very steady, allowing the compass scale to come to a rest. Read and record the bearing to the nearest degree. Be careful in reading the bearing from the scale, use large numbers (small numbers are the back azimuth) and note that scale values decrease from left to right. Large scale interval is 5 degrees, smallest interval is 1 degree. Practice and periodically compare compass readings with your partner to verify their accuracy. Measurements are to the nearest whole degree, magnetic (as opposed to true) north.

Use of Sonin Combo Pro: Read the Sonin manual. We will only use it in the target or dual unit mode. Turn main "receiver" unit on by pressing switch up to the double icons, turn "target" unit on and slide the protector shield up. The units power down automatically after 4 minutes of inactivity. Position units at opposite ends of segment to be measured, pointing the receiver sensors in a perpendicular orientation towards the target sensors. Note: The measurement is calculated from the base of the receiver and the back of the target, position units accordingly so that you measure precisely the distance you intended. Press and hold down the button with the line over the triangle symbol. The receiver will continue to take and display measurements as long as you depress the button. Wait until you achieve a consistent measurement, then release the button to freeze the measurement. Measures initially appear in feet/inches. To obtain conversions, press and hold the "C" button until the measure is converted to the units you want (metric or tenths of a foot). Turn units off and store in protective case following use. Unit range is supposed to be 250 ft. (75m); be careful and take multiple measures for distances over 100 feet. Under optimal conditions accuracy is within 4 in. (10cm) at 60 ft. (18.3 m). Device can be affected by temperature, altitude and barometric pressure, and noise (even strong wind). The units are not waterproof. Batteries: Carry spare batteries (two 9-volt alkaline). Measurements are to the nearest 0.1 meter.
Standard Operating Procedure (SOP) #3: Full Assessments

Version 1.0

Change History

Version numbers will be incremented by a whole number (e.g. Version 1.3 to Version 2.0) when a change is made that significantly affects requirements or procedures. Version numbers will be incremented by decimals (e.g. Version 1.6 to Version 1.7) when there are minor modifications that do not affect requirements or procedures.

The following revisions have occurred to this plan since Month Year

<table>
<thead>
<tr>
<th>Version #</th>
<th>Date</th>
<th>Revised by</th>
<th>Changes</th>
<th>Justification</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This Standard Operating Procedure (SOP) identifies procedures used in the field to measure and assess campites.

Assessment Types

Survey Area

Upon arrival at a beach, the first task is to survey (walk or visually inspect by other means) and identify all potential features for assessment. Avoid creating new trails or impacting the perimeter of campsites. Two options exist for mapping, either a) walking (while collecting GPS data) a line with a specified, fixed buffer distance being the area surveyed or b) walking the perimeter of the area.

1. **Region**: Choose from the drop down menu Resurrection, Aialik, Northwestern, Outer Coast, Nuka, and Exit.

2. **Beach Name**: Use the beach name for the area. If there is no commonly used name, use the name of the most prominent geographical feature nearby (Example: Bear Cove or Pederson Lagoon). This field can be left blank for later completion in the office.

3. **Location Description**: Describe the location of the campsite using local geographic features and distances in sufficient detail so that someone five years later could relocate the site. (e.g. ten meters north of boundary marker).
4. **Surveyed By:** List the names of field personnel involved in data collection.

5. **Comments:** add as needed.

**Unofficial Trails**

The second task that helps identify subsequent campsite radial transect data collection is to map and assess condition of all trails. Avoid creating new trails or impacting the perimeter of campsites.

1. **Region:** Choose from the drop down menu Resurrection, Aialik, Northwestern, Outer Coast, Nuka, and Exit.

2. **Beach Name:** Use the beach name for the area. If there is no commonly used name, use the name of the most prominent geographical feature nearby (Example: Bear Cove or Pederson Lagoon). This field can be left blank for later completion in the office.

3. **Surveyed By:** List the names of field personnel involved in data collection.

4. **Trail Type:** identify if the trail is a designated (maintained) path, visitor-created, or other (i.e. wildlife or geomorphic feature).

5. **Trail Width:** estimate width as '<50cm', '50-100cm', or '>1m'.

6. **Unofficial Trail Condition Class Definitions:**

<table>
<thead>
<tr>
<th>Condition Class</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Trail distinguishable; slight loss of vegetation cover and/or minimal disturbance of organic litter.</td>
<td></td>
</tr>
<tr>
<td>2 Trail obvious; &gt; 50% vegetation cover lost primary use areas; slight loss of organic litter</td>
<td></td>
</tr>
<tr>
<td>3 Nearly complete or total loss of vegetation cover and organic litter within the tread, bare mineral soil prevalent</td>
<td></td>
</tr>
<tr>
<td>4 Complete or total loss of vegetation cover and organic litter within the tread, some erosion present indicated by exposed roots and rocks and/or gullying</td>
<td></td>
</tr>
<tr>
<td>5 Soil erosion severe, as indicated by exposed roots and rocks and gullying exceeding 25cm in depth.</td>
<td></td>
</tr>
</tbody>
</table>

7. **Comments:** add as needed.

**Campsites**
Radial Transect and flag placement should go first!! Follow the instructions on the following pages on how to perform the variable radial transect and geometric figure methods of campsite measurement. The variable transect method is used for all main campsites. The geometric figure method is reserved for satellite campsites needing only a general idea of the size and shape of the site. It is important that great care is taken in establishing these measurements. Future campsite re-measurements rely on accurate original measurements.

Once the campsite center point has been selected, perimeter outlines, sketches drawn, and photographs taken, using a nylon wire tie connect the numbered aluminum tag to a 6 inch or larger bolt. The tag number corresponds to the number assigned to the campsite. Embed the steel bolt and tag in the soil, sand or gravel at the center point location so that the head only two inches below the surface. During future campsite assessments a magnetic pin locator can be used to locate the center point.

1. **Tag Number:** If monitoring a new visitor site, use the number on the aluminum tag to be buried at the center point. If re-measuring a visitor site, use the original visitor site number. If you cannot locate the original tag at the center point, bury a new tag (with a different number than the original tag) as close as possible to where you believe center point is. Make a note on the form that a new, differently numbered, tag has been buried.

2. **Location Description:** Describe the location of the campsite using local geographic features and distances *in sufficient detail so that someone five years later could relocate the site.* (e.g. ten meters north of boundary marker).

3. **Area Measure Type:** Choose from the drop down menu the type of measurement for this location either Radial Transect, Image Analysis, Geometric, None, GPS Perimeter, or Other. This protocol details and recommends the radial transect method whenever possible. The variable transect method is used for all main campsites.

4. **Distance From High Tide Line:** Measure the distance between high tide line and the center point of the visitor site in meters. The high tide line can be determined by a linear accumulation of sea debris. Measurement precision is 0.1 meter.

5. **Landing Substrate:** Record the predominant substrate for this site choosing one of the coded categories below from the drop down menu.
   1. Bedrock - shelf bedrock
   2. Cobble - includes gravel size stone and up
   3. Sand - includes sandy beach soils which do not form a surface crust in trampled areas
   4. Soil - includes clays to loamy sands
   5. Sand/Cobble - combination of sand and cobble
   6. Soil/Cobble - combination of soil and cobble

6. **Camping Site Substrate:** Record the predominant substrate for this site choosing one of the coded categories below from the drop down menu.
   1. Bedrock - shelf bedrock
   2. Cobble - includes gravel size stone and up
   3. Sand - includes sandy beach soils which do not form a surface crust in trampled areas
   4. Soil - includes clays to loamy sands
   5. Sand/Cobble - combination of sand and cobble
   6. Soil/Cobble - combination of soil and cobble

7. **Tree Canopy Cover:** Mark *yes* or *no* if there is live tree canopy above visitor site.
8. **Cover Onsite:** An estimate of the percentage of live non-woody vegetative ground cover (including herbs, grasses, and mosses. Exclude tree seedlings, saplings, and shrubs) within the campsite boundaries using the categories listed below. Exclude undisturbed "islands" of vegetation. For this and the following two parameters, it is often helpful to narrow your decision to two categories and concentrate on the boundary that separates them. For example, if the vegetation cover is either the 6-25% category or the 26-50% category, you can simplify your decision by focusing on whether vegetative cover is greater than 25%. Do not extrapolate the amount of ground cover that could or should be seen. Use total leaf coverage not stem or stock coverage to determine percent. Refer to the color photos provided in this manual for further guidance.

   **Cover Categories:**
   - 0-5%
   - 6-25%
   - 26-50%
   - 51-75%
   - 76-95%
   - 96-100%

9. **Cover Offsite:** An estimate of the percentage of vegetative ground cover in an adjacent but largely undisturbed "control" area. Use the categories listed below. The control site should be similar to the campsite in slope, tree canopy cover (amount of sunlight penetrating to the forest floor), and other environmental conditions. The intent is to locate an area which would closely resemble the campsite area had the campsite never been used. In instances where you cannot decide between two categories, select the category with less vegetative cover. The rationale for this is simply that, all other factors being equal, the first campers would have selected a site with the least amount of vegetation cover. Refer to the color photos provided in this manual for further guidance.

   **Cover Categories:**
   - 0-5%
   - 6-25%
   - 26-50%
   - 51-75%
   - 76-95%
   - 96-100%

10. **Mineral Soil Exposure:** Mineral soil is soil with approximately 20-30% organic material or less. Mineral matter includes gravel, sand, cobbles, and bedrock. Dark organic soil, which typically covers lighter colored mineral soil, should be assessed as bare soil. Assessments of soil exposure may be difficult when organic litter becomes highly decomposed and forms a patchwork with areas of bare soil. If patches of organic material are relatively thin and few in number, the entire area should be assessed as bare soil. Otherwise, the patches of organic litter should be mentally combined and excluded from assessments. Refer to the color photos provided in this manual for further guidance. Code as below.

   **Cover Categories:**
   - 0-5%
   - 6-25%
   - 26-50%
11. **Tree Damage:** Calculate the extent of damage to trees within 5 meters of campsite. Only count trees with damage. Do not count tree stumps as tree damage. Omit scars that are clearly not human-caused (e.g. windfall or bear damage). If there is any question about the level of damage for a tree, photograph the damage and make your best call.

1. **None to Slight** – Slight damage such as broken or cut smaller branches, one or two nails, or a few superficial scars on the trunk. In some areas with dense forests of young spruce, virtually all of the trees have had their lower, dead branches removed for fire starter.
2. **Moderate** - Numerous small trunk scars and nails or one major cut or broken branch.
3. **Severe** - Trunk scars numerous with many that are large and have penetrated to the inner wood; any complete girdling of tree (cutting through tree bark all the way around tree) and any burn scars. Any new severe tree damage should be photographed.
4. **N/A** Site is not located within 5 meters of trees.

**12. Root Exposure:** This refers to the roots exposed due to trampling and erosion caused by human impacts. Omit root exposure that is clearly not human-caused (e.g., stream/river flooding or beach erosion).

1. **None to Slight** – Slight root exposure such as is typical in adjacent offsite areas.
2. **Moderate** – One major root system exposed or a few minor roots exposed.
3. **Severe** - Three-quarters or more of major roots exposed more than one foot from base of tree, soil erosion obvious.
4. **N/A**

**13. Number of Stumps:** Count the number of tree stumps associated with the campsite (within 5 meters of the campsite or trail from campsite) that were obviously cut by saw or axe. Do not count old, broken stumps that were not obviously cut. Do not include cut stems from a multiple stemmed tree. Count all numbers of stumps and enter the number.

**14. Number of Ghost Stumps:** Count the number of ghost tree stumps associated with the campsite (within 5 meters of the campsite or trail from campsite) that were obviously cut by saw or axe. Do not count old, broken stumps that were not obviously cut. Count all numbers of stumps and enter the number.

**15. Number of Fire Sites:** Tally the number of fire sites within 5 meters of the campsite boundaries and enter the number. Include old inactive fire sites as exhibited by blackened rocks, charcoal, or ashes. Do not include locations where charcoal or ashes have been dumped. In cases where a
fire sites is some distance from the campsite, assess this as an “Other Visitor Site” and collect a separate GPS location

16. **Number of Trails:** Count all trails that leave the campsite in any direction and enter the number. If the visitor site is open to the beach and no access trails are necessary to reach the visitor site(s), trails may not exist because access is freely gained anywhere.

17. **Number of Tent Rocks:** Count all rocks moved by humans associated within site boundaries. From the drop down menu choose between None, 1-5, 6-15, or >15.

18. **Trash:** Include all recreational use litter or trash that is seen when standing at the center point of the campsite. Note: flotsam is not included in the choosing of the appropriate category.
   1. None to a handful of trash
   2. More than a handful to a gallon bucket
   3. Gallon to 5 gallon bucket
   4. Greater than 5 gallon bucket

19. **Human Waste:** Follow all trails connected to the site to conduct a quick search of likely "toilet" areas, typically areas just out of sight of the campsite. Count the number of individual human waste sites, defined as separate locations exhibiting toilet paper and/or human feces. The intent is to identify the extent to which improperly disposed human feces is a problem. Use the following coded categories:
   1. None
   2. 1 to 3 sites evident
   3. 4 or more sites evident

20. **Condition Class:** This category refers to vegetation loss, changes in soil, amount of tree damage, root exposure, number of trails, and erosion compared between inside the campsite perimeter and outside the campsite perimeter. This question must be filled out after the entire inventory form has been completed. Refer to the following descriptions and to the photographs at the end of this manual. To determine vegetation cover loss see the formula and chart below. Note: trash or human made structures should not be counted towards condition class rather the evaluation is specific to resource damage.

**Table 1. Condition class definitions**

<table>
<thead>
<tr>
<th>Class</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class 0:</td>
<td>Describes a previously established site that has re-grown and is not showing observable disturbance. This class can only be used for re-measurement of an established site</td>
</tr>
<tr>
<td></td>
<td>Recreation site barely distinguishable</td>
</tr>
<tr>
<td></td>
<td>None or minimal disturbance of vegetation and/or organic litter</td>
</tr>
<tr>
<td></td>
<td>No observable vegetation loss in campsite as compared to off site</td>
</tr>
<tr>
<td>Class 1:</td>
<td>Recreation site barely distinguishable</td>
</tr>
<tr>
<td></td>
<td>Slight loss of vegetation cover and/or minimal disturbance of organic litter</td>
</tr>
<tr>
<td></td>
<td>6-25% vegetation loss in campsite as compared to off site</td>
</tr>
<tr>
<td>Class 2:</td>
<td>Recreation site obvious</td>
</tr>
<tr>
<td></td>
<td>Vegetation cover lost and/or organic litter pulverized in primary use areas</td>
</tr>
<tr>
<td></td>
<td>26-50% vegetation loss in campsite as compared to off site</td>
</tr>
<tr>
<td>Class 3:</td>
<td>Vegetation cover lost and/or organic litter pulverized on much of the site</td>
</tr>
<tr>
<td></td>
<td>Some bare soil exposed in primary use areas</td>
</tr>
</tbody>
</table>
51-75% vegetation loss in campsite as compared to off site

Class 4:  
- Nearly complete or total loss of vegetation cover and organic litter
- Bare soil widespread
- 76-95% vegetation loss in campsite as compared to off site

Class 5:  
- Soil erosion obvious, indicated by exposed tree roots and rocks and/or gullies formed
- 96-100% vegetation loss in campsite as compared to off site

21. **Comments:** Write all pertinent comments regarding the impact in this area. These notes are extremely valuable to future surveyors. Note any assessments that you felt were particularly difficult or subjective, problems with monitoring procedures or their application to this particular campsite, recommendations regarding site management, or any other comments.

22. **Field Notes:** Mark yes or no if you have relevant, additional field notes.

23. **Excel Link:** Via the menu select the name of the Excel file containing the radial transect data. The excel file must first be created, preferably in the 'Terrasync' file folder named with the pin number.
   - Row 1 = Column A entry should be "a" representing azimuth and Column B entry should be "d" representing distance.
   - Column A = Azimuth to each flag in whole degrees, magnetic north
   - Column B = Distance to each pin flag to the nearest 0.1 meter.

24. **Campsite Pictures:**

**Photo Points**

Photo point monitoring is conducted at locations where site boundaries are indeterminate, such as a beach with vegetation loss and disturbance, but no clear sites forming.

1. **Region:** Choose from the drop down menu Resurrection, Aialik, Northwestern, Outer Coast, Nuka, and Exit.

2. **Beach Name:** Use the beach name for the area. If there is no commonly used name, use the name of the most prominent geographical feature nearby (Example: Bear Cove or Pederson Lagoon). This field can be left blank for later completion in the office.

3. **Surveyed By:** List the names of field personnel involved in data collection.

4. **Photo Point Type:** identify type of feature being photographed:
   - Tagged campsite
   - Fire evidence
   - Miscellaneous

5. **Tag Number:** campsite tag number, as appropriate.

6. **Camera height:** camera height above ground, in meters.

7. **Bearing:** direction (azimuth) of view, in magnetic north to nearest whole degree.

8. **Comments:** add as needed.
Other Visitor Sites
Photo point monitoring is conducted at locations where site boundaries are indeterminate, such as a beach with vegetation loss and disturbance, but no clear sites forming.

1. **Region:** Choose from the drop down menu Resurrection, Aialik, Northwestern, Outer Coast, Nuka, and Exit.

2. **Beach Name:** Use the beach name for the area. If there is no commonly used name, use the name of the most prominent geographical feature nearby (Example: Bear Cove or Pederson Lagoon). This field can be left blank for later completion in the office.

3. **Surveyed By:** List the names of field personnel involved in data collection.

4. **Feature Type:** identify type of feature being photographed:
   - Fire Site- human origin, no other resource impacts present
   - Tent Rock sites
   - Beach Furniture

5. **Comments:** add as needed.

**Generic Feature**
For other features which do not fit into these broad categories, either point, line, or area. Whenever possible and appropriate, the above assessment types should be used.
Nominal and Physical Campsite Information

Variable Radial Transect Method Details

Step 1. Identify campsite boundaries and flag transect endpoints. Walk the campsite boundary and place flagged wire pins at locations which, when connected with straight lines, will define a polygon whose area approximates the campsite area. Use as few pins as necessary, typical campsites can be adequately flagged with 10-20 pins. Look both directions along campsite boundaries as you place the flags and try to balance areas of the campsite that fall outside the lines with offsite (undisturbed) areas that fall inside the lines. Pins do not have to be placed on campsite boundaries, as demonstrated in the diagram at the left. Project campsite boundaries straight across areas where trails enter the campsite.

Step 2. Select and reference campsite centerpoint. Select a campsite centerpoint that is 1) visible from all the campsite boundary pins, and 2) easily referenced by distinctive permanent features such as larger trees or boulders. Place a steel bolt at the centerpoint and collect GPS data on that centerpoint.

Step 3. Record transect azimuths and lengths using Pocket Excel in the Trimble GPS. Standing directly over the centerpoint, identify and record the compass bearing (azimuth, from magnetic north) of each campsite boundary pin working in a clockwise fashion (in the exact order you would encounter them if you were walking the campsite boundary). Be careful not to miss any pins hidden behind vegetation or trees. Be extremely careful in identifying the correct compass bearings to these pins as error in these bearing will bias current and future measurements of campsite size. Along with each azimuth, record the distance to each flag by using the Sonin Combo Pro and enter them into the Trimble Pocket Excel. You may also anchor the end of your tape to the centerpoint bolt, measure and record the length of each transect (nearest tenth of a meter), starting with the same boundary pin and in the same clockwise order as before. Be absolutely certain that the appropriate pin distances are recorded adjacent to their respective compass bearings. Leave boundary pins in place until you finish all other measurements.

Step 4. Take photographs that clearly shows the centerpoint location in relation to nearby trees or other reference features. Use a marker board at the pin site labeled with the site (pin) number and visible in the photograph. At a minimum take two photographs in the following order: 1) from the south end of the delineated site facing towards magnetic north, then 2) from the north end of the site facing magnetic south, and 3) when possible photos at the pin location facing magnetic east and then magnetic west.
**Geometric Figure Method Details**

This method for determining the area of campsites, "satellite" campsites, and interior undisturbed "island" sites is relatively rapid and is accurate if applied with good judgment. Begin by carefully studying the site's shape, as if you were looking down from above. Mentally superimpose and arrange one or more simple geometric figures to closely match the site boundaries. Any combination and orientation of these figures is permissible; see the examples below. Measure (nearest meter) the dimensions necessary for computing the area of each geometric figure. It is best to complete area computations in the office with a calculator to reduce field time and minimize errors.

Good judgment is required in making the necessary measurements of each geometric figure. As boundaries will never perfectly match the shapes of geometric figures, you will have to mentally balance disturbed and undisturbed areas included and excluded from the geometric figures used. For example, in measuring an oval site with a rectangular figure, you would have to exclude some of the disturbed area along each side in order to balance out some of the undisturbed area included at each of the four corners. It may help, at least initially, to place plastic tape or wire flags at the corners of each geometric figure.
used. In addition, be sure that the opposite sides of rectangles or squares are the same length and that the triangles you use are right triangles.

![Geometric Figures](image)

\[
A = l \times w \quad A = 0.5 \times b \times h \quad A = 3.14 \times r \times r
\]

**Figure 2.** Illustration of geometric figure measurements.

**Re-Measurement Details**

To re-measure a campsite you first need to find the buried center point tag. This can be difficult and frustrating. Use a magnetic pin locator and try to locate the buried tag without disturbing the campsite too much. It is important that you find the tag in the exact location where it was buried. If you dig too vigorously while looking for the tag it will most likely move. Hopefully, there is a photograph that distinctly shows the center point to help in this process. Once you find the original center point, use the following detailed instructions on campsite re-measurement. This method of re-measurement is time consuming and relies on the accuracy of the original measurements.

These additional procedures are designed to eliminate much of the measurement error associated with different individuals making subjective judgments on those campsites or portions of campsites where boundaries are not pronounced. These procedures may only be used for campsites whose center points can be relocated. If you are unable to locate the center point then measure the campsite as if it were a new campsite, use a new tag and make a note of the new and old numbers on the data sheet.

**Re-measurement:** During campsite re-measurement use the data from the last monitoring period to reestablish the center point and all campsite boundary pins. If steel center point bolts were embedded in
the ground, a magnetic pin locator can assist in this process. Place flagged wire pins at each transect boundary point. Boundary locations based on the following procedures:

1. Keep the same transect length if that length still seems appropriate, i.e., there is no compelling reason to alter the initial boundary determination.

2. Record a new transect length if the prior length is inappropriate, i.e., there is compelling evidence that the present boundary does not coincide with the pin and the pin should be relocated either closer to or further from the center point along the prescribed compass bearing. Use different colored flags to distinguish these current boundary points from the former boundaries.

3. Repeat Steps 1 and 3 from above to establish additional transects where necessary to accommodate any changes in the shape of campsite boundaries (diagram below). Also repeat Step 4.

4. Leave all pins in place until all procedures are completed. Pins identifying the former campsite boundaries are necessary for tree damage and root exposure assessments.

![Diagram of re-measurement using variable radial transect method.](image)

**Figure 3.** Illustration of re-measurement using variable radial transect method.
Standard Operating Procedure (SOP) #4: Rapid Assessments

*Version 1.0*

**Change History**

Version numbers will be incremented by a whole number (e.g. Version 1.3 to Version 2.0) when a change is made that significantly affects requirements or procedures. Version numbers will be incremented by decimals (e.g. Version 1.6 to Version 1.7) when there are minor modifications that do not affect requirements or procedures.

The following revisions have occurred to this plan since *Month Year*

<table>
<thead>
<tr>
<th>Version #</th>
<th>Date</th>
<th>Revised by</th>
<th>Changes</th>
<th>Justification</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This Standard Operating Procedure (SOP) identifies procedures used in the field to conduct rapid assessments of campsites.
Standard Operating Procedure (SOP) #5: Electronic Workspace Management

Version 1.0

Change History

Version numbers will be incremented by a whole number (e.g. Version 1.3 to Version 2.0) when a change is made that significantly affects requirements or procedures. Version numbers will be incremented by decimals (e.g. Version 1.6 to Version 1.7) when there are minor modifications that do not affect requirements or procedures.

The following revisions have occurred to this plan since Month Year

<table>
<thead>
<tr>
<th>Version #</th>
<th>Date</th>
<th>Revised by</th>
<th>Changes</th>
<th>Justification</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This Standard Operating Procedure (SOP) explains the requirements for managing photographs.

This document will guide you through this summer’s field season, including collecting data using Trimble GPS units and a customized Data Dictionary, data management, taking photographs, and more. The protocol itself is a GPS-based method to map and monitor coastal backcountry campsites and collect relevant information about them. The data will become part of an ESRI GeoDatabase that spans multiple years. At the start of each field season, the KEFJ Coastal Campsite Program coordinator will update the campsite monitoring protocol after consulting with the regional GIS specialists regarding changes to recommended GPS settings and post-processing guidelines.

General File Management
In an effort to organize data that works well now and for future users of the files, the electronic file structure is described:

1. Data, reports, photos, protocols, and other files associated with the KEFJ Coastal Campsite Monitoring Program are located at H:\Projects_Active\Management\Campsite_Monitoring\.
2. Data and photos should be organized by year in their respective subdirectories.
3. See Table 1 for the KEFJ network directory file structure.
Table 1. Description of KEFJ Coastal Campsite Monitoring program general directory structure.

<table>
<thead>
<tr>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>H:\Projects_Active\Management\Campsite_Monitoring</td>
<td>Storage of all electronic files associated with the KEFJ Coastal Campsite Monitoring Program.</td>
</tr>
<tr>
<td>H:\Projects_Active\Management\Campsite_Monitoring\Administrative</td>
<td>All documents related to agreements, proposals, and presentations.</td>
</tr>
<tr>
<td>H:\Projects_Active\Management\Campsite_Monitoring\Data</td>
<td>All GIS, GPS and tabular data organized by year and data dictionaries.</td>
</tr>
<tr>
<td>H:\Projects_Active\Management\Campsite_Monitoring\Photos</td>
<td>All project photos organized by year.</td>
</tr>
<tr>
<td>H:\Projects_Active\Management\Campsite_Monitoring\Protocols</td>
<td>All campsite monitoring protocols.</td>
</tr>
<tr>
<td>H:\Projects_Active\Management\Campsite_Monitoring\References</td>
<td>All campsite monitoring reference documents including journal articles, protocols, and gray literature.</td>
</tr>
<tr>
<td>H:\Projects_Active\Management\Campsite_Monitoring\Reports</td>
<td>All draft and final KEFJ campsite monitoring reports.</td>
</tr>
</tbody>
</table>
Standard Operating Procedure: GPS and Camera Setup

Version 1.0

Change History

Version numbers will be incremented by a whole number (e.g. Version 1.3 to Version 2.0) when a change is made that significantly affects requirements or procedures. Version numbers will be incremented by decimals (e.g. Version 1.6 to Version 1.7) when there are minor modifications that do not affect requirements or procedures.

The following revisions have occurred to this plan since Month Year

<table>
<thead>
<tr>
<th>Version #</th>
<th>Date</th>
<th>Revised by</th>
<th>Changes</th>
<th>Justification</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This Standard Operating Procedure (SOP) explains the requirements for managing photographs.

This protocol does not provide instructions on the operation of Trimble GPS units. The KEFJ Coastal Campsite Program will be using primarily Trimble GeoXT receivers and TerraSync and Pathfinder Office software. At the start of every field season, check with the KEFJ GIS coordinator to make sure you are running the most current software/firmware versions. More detailed protocols on GPS operation should be addressed through Trimble training provided by Joel Cusick (907-644-3549). Reviewing his training binder may be helpful. In addition, many GPS solutions are posted on the AKR GPS web pages: [http://inpakroms03web/rgr/gps/tips.htm](http://inpakroms03web/rgr/gps/tips.htm) and [http://inpakroms03web/rgr/akgis/index.cfm?action=dsp&topic=gps&item=gps](http://inpakroms03web/rgr/akgis/index.cfm?action=dsp&topic=gps&item=gps). Finally, these TerraSync guides provide good information – Getting Started Guide and Quick Start Guide.

GPS Housekeeping at Start of Season

What legacy data will you be carrying around with you this season? None, if you do the proper housekeeping! This will speed up your unit and ensure plenty of storage space.

1. Using PFO, download all the rover files to a backup folder and notify your park’s GIS personnel or past users of file locations.
2. In Windows Explorer with your unit connected to the computer, select the Mobile Device from My Computer.
3. Navigate to \Disk\My Documents\TerraSync (most likely location), copy all files to a backup folder on your computer, then delete them from your GPS. Look into other folders as well.

4. Backup your GPS unit (Start>Backup Now).

5. In TS on the GPS, use the File Manager (Data>File Manager) to delete all previous data that is no longer needed. For example, old rover files, data dictionaries, backgrounds, etc. Some background files may still be useable if made for a similar area or purpose.

6. Backup your GPS again.

GPS Transfers

To have the GPS communicate with the computer, you must have Microsoft ActiveSync installed on the computer. Once ActiveSync is installed, the GPS cradle is connected to the computer, and the GPS (already on) is placed in the cradle, the GPS should connect to the computer. If you have problems, try restarting the computer, reconnecting the GPS, and reconnecting the cradle. If you still have problems, contacting the KEFJ GIS coordinator.

GPS Settings

Files must be initially transferred to the Trimble unit using the Data Transfer utility in Pathfinder Office. Use the same GPS settings recommended by the AKR Exotic Plant Management Team (EPMT) program. These can be obtained in downloadable files from the EPMT program lead at the start of each field season. See W:\ARO\NaturalResources\EPMT for current files. If you need help locating the settings files, contact the KEFJ GIS coordinator. Never transfer Trimble associated files using Explorer or any other means than the Data Transfer utility.

Transfer the following files to the GPS:

3. Navigate to \Disk\My Documents\TerraSync (most likely location), copy all files to a backup folder on your computer, then delete them from your GPS. Look into other folders as well.

4. Backup your GPS unit (Start>Backup Now).

5. In TS on the GPS, use the File Manager (Data>File Manager) to delete all previous data that is no longer needed. For example, old rover files, data dictionaries, backgrounds, etc. Some background files may still be useable if made for a similar area or purpose.

6. Backup your GPS again.

GPS Transfers

To have the GPS communicate with the computer, you must have Microsoft ActiveSync installed on the computer. Once ActiveSync is installed, the GPS cradle is connected to the computer, and the GPS (already on) is placed in the cradle, the GPS should connect to the computer. If you have problems, try restarting the computer, reconnecting the GPS, and reconnecting the cradle. If you still have problems, contacting the KEFJ GIS coordinator.

GPS Settings

Files must be initially transferred to the Trimble unit using the Data Transfer utility in Pathfinder Office. Use the same GPS settings recommended by the AKR Exotic Plant Management Team (EPMT) program. These can be obtained in downloadable files from the EPMT program lead at the start of each field season. See W:\ARO\NaturalResources\EPMT for current files. If you need help locating the settings files, contact the KEFJ GIS coordinator. Never transfer Trimble associated files using Explorer or any other means than the Data Transfer utility.

Transfer the following files to the GPS:
1. **Configuration file** (obtain current version from AK EPMT program) following the instructions in the associated word file. If you get an error on the GPS, you are likely not running the current version of TerraSync. For GPS receivers not using TerraSync, contact the Alaska Region GIS Team.

2. KEFJ Coastal Campsite **Data Dictionary** file (found at H:\Projects_Active\Management\Campsite_Monitoring\Data\PFO_Data_Dictionary) after you have arranged the fields for your own convenience using the Data Dictionary editor utility in Pathfinder Office. There are two data dictionaries depending on the type of survey you are performing: 1) Rapid Assessment or 2) Full Assessment.
   a. **Do not** remove or add attribute values or data fields.
   b. Arrange the order of attribute values using the up and down arrows so that the ones you use most commonly are at the top of each list. For example, your name and common locations.
   c. Any field you alter as described above must be altered in all feature classes (Pnt2Buf, Line2Buf, Poly, etc). An easy way to do this is by copying the data field you’ve altered (ctrl+c), then pasting it into the other feature classes (ctrl+v), and then deleting the duplicate unaltered field it replaces (Delete key).
   d. Load the data dictionary onto your GPS unit.

**Set time zone:**
1. Go to the “Start” menu of the Trimble unit
2. Tap on “Settings”
3. On the “System” tab, tap on “Clock”
4. Verify that the time zone is set to “GMT-9 Alaska” and tap OK.
5. Is the time right after the unit has been outside and received satellite information?
6. Due to the recent changes in Daylight Savings Time, Mobile 2003 units and newer have patches to correct for the time of year shifts. See Joel Cusick’s cheat sheet on updating time.

To standardize our Trimble units for data collection, we are using a configuration file that sets the most important GPS settings to predetermined values.
1. Open up TerraSync on the unit (tap F1)
2. Select “Setup” from the main menu.
3. Below the “Current Configuration:” box, tap on the box labeled “Change”
4. Select the current EPMT configuration file from the menu and tap on “Load”
5. Tap on the “Logging Settings” box from the “Setup” screen.
6. By default, the antenna height is 1.5m. Click on the wrench icon and change the height to your own chest height. You should hold the GPS at this height to collect data. You can enter a height in feet (enter a value “4.25 ft”) and it will automatically convert to meters (“1.295 m”).
7. Still in “Logging Settings,” change the “Filename Prefix” (default ‘R’) to the first letter of your last name.

**GPS Background Images**

Having a background file display on your GPS or in PFO can be very helpful to navigate to a new location or verify that data is correctly recorded. To get a background image to display, you must create a jpg file in ArcGIS, transfer the file, and verify the coordinate systems of the GPS.
1. Navigate to the following project directory: 
   H:\Projects_Active\Management\KEFJ_Coastal_Campsite_Monitoring\Data\GIS.
2. Open the ArcGIS map document named: KEFJ_Coastal_Campsites.mxd. There you will 
   find helpful information including background photos, USGS topographic maps, NOAA 
   charts, previous data, park boundaries, trails, etc.
3. Confirm the map coordinate system by double clicking on the “Layers” icon in the right 
   navigation window. Look at the “Coordinate System” tab. The map should be in a projected 
   coordinate system (Alaska_Albers_Equal_Area_Conic).
4. Once the data is arranged as you would like it and the screen has the map extent that you 
   want (zoom in and out to export what is visible in the window), select “Export Map” from 
   the “File” menu.
5. Experiment with different resolutions and qualities. Having a background image will slow 
   down GPS map drawing, so you need to balance between speed and image quality. The 
   higher the resolution and quality, the slower the image will redraw. Since map drawing is 
   affected by how large the map is, you may want to create several smaller maps for different 
   study areas so the GPS has less to redraw at any one time.
6. Check the “Write World File” option and save the map. Adding the resolution to the end of 
   the file name will help remind you of what files are larger and smaller.
7. Open PFO (testing the image in PFO will save you much anguish with the GPS).
8. Select “Coordinate System” in the “Options” window. Define the coordinate system to 
   match the exported map. This is only changing how the data is displayed, not how it is 
   collected or saved. See Table 2 for the correct settings based on the projection of your 
   image. If these options aren’t showing up, you probably do not have the most current version 
   of coordinate system software. To fix, close PFO. Go to C:\Program Files\Common 
   Files\Trimble\GeoData and backup current.csd (make a copy and paste in same folder). 
   Then delete the file current.psd. Re-launch PFO, and it should rebuild the file and provide 
   the needed options.
9. Make sure “Coordinate Units” is in meters and hit “OK.”
10. Load the background in PFO by selecting “Background” from the “File” menu. Click “Add” 
    and navigate to the image.
11. Change the coordinate system to match the coordinates you just established for PFO.
12. Select “OK” and the image should load.
13. Verify the image is correctly positioned by opening a data file (.ssf or .cor) and verify that 
    the features align with the image.
14. Connect your GPS to the computer.
15. Using PFO, transfer the image to the GPS using the “Send” tab and “Add”ing a 
    “Background.”
17. Change the “Coordinate System” to match those defined in PFO (Table 2).
18. Go to “Map” and under “Layers” select “Background File.” Choose the correct file.
19. Under “Layers”, make sure the “Background” option is checked. Image should display and 
    you won’t get an error if all the coordinate systems were properly assigned.
Table 2 – Coordinate settings required for Albers for use in ArcGIS, Pathfinder Office, and TerraSync.

<table>
<thead>
<tr>
<th>ArcGIS Coordinate System</th>
<th>Alaska_Albers_Equal_Area_Conic (using NAD83)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data Frame Properties</strong></td>
<td></td>
</tr>
<tr>
<td>Annotation Groups:</td>
<td></td>
</tr>
<tr>
<td>Extent Rectangles:</td>
<td></td>
</tr>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Data Frame</td>
<td></td>
</tr>
<tr>
<td>Coordinate System</td>
<td></td>
</tr>
<tr>
<td>Current coordinate system:</td>
<td></td>
</tr>
<tr>
<td>Alaska_Albers_Equal_Area_Conic \ Projection: Albers</td>
<td></td>
</tr>
<tr>
<td>False_Easting: 0.000000</td>
<td></td>
</tr>
<tr>
<td>False_Northing: 0.000000</td>
<td></td>
</tr>
<tr>
<td>Central_Meridian: -154.000000</td>
<td></td>
</tr>
<tr>
<td>Standard_Parallel_1: 0.000000</td>
<td></td>
</tr>
<tr>
<td>Standard_Parallel_2: 0.000000</td>
<td></td>
</tr>
<tr>
<td>Latitude_OF_Origin: 0.000000</td>
<td></td>
</tr>
<tr>
<td>Linear_Unit: Meters</td>
<td></td>
</tr>
<tr>
<td>GCC_North_American_1983</td>
<td></td>
</tr>
<tr>
<td>Datum: D_North_American_1983</td>
<td></td>
</tr>
</tbody>
</table>

| Select a coordinate system: | Alaska_Albers_Equal_Area_Conic |

<table>
<thead>
<tr>
<th>Pathfinder Office Coordinate System</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Coordinate System</strong></td>
</tr>
<tr>
<td>Select By</td>
</tr>
<tr>
<td>Coordinate System and Zone</td>
</tr>
<tr>
<td>Zone: Alaska Albers83 (CORS 96)</td>
</tr>
<tr>
<td>Datum: NAD 1983 (Conus) CORS96</td>
</tr>
<tr>
<td>Altitude Measured From</td>
</tr>
<tr>
<td>Height Above Ellipsoid (NAE)</td>
</tr>
<tr>
<td>Mean Sea Level (MSL)</td>
</tr>
<tr>
<td>Altitude Units: Meters</td>
</tr>
<tr>
<td>Coordinate Units: Meters</td>
</tr>
<tr>
<td>Altitude Units: Meters</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TerraSync Coordinate System</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>System: US Continental</strong></td>
</tr>
<tr>
<td>Zone: Alaska Albers83 (CORS 96)</td>
</tr>
<tr>
<td>Datum: NAD 1983 (Conus) CORS96</td>
</tr>
<tr>
<td>Altitude Reference: Mean Sea Level (MSL)</td>
</tr>
<tr>
<td>Altitude Units: Meters</td>
</tr>
<tr>
<td>Geoid Model: Other</td>
</tr>
<tr>
<td>Geoid: DMA 10x10 (Global)</td>
</tr>
<tr>
<td>Coordinate Units: Meters</td>
</tr>
<tr>
<td>Display USNG: Off</td>
</tr>
</tbody>
</table>
Standard Operating Procedure: Collecting GPS and Photo Data

Version 1.0

Change History

Version numbers will be incremented by a whole number (e.g. Version 1.3 to Version 2.0) when a change is made that significantly affects requirements or procedures. Version numbers will be incremented by decimals (e.g. Version 1.6 to Version 1.7) when there are minor modifications that do not affect requirements or procedures.

The following revisions have occurred to this plan since Month Year

<table>
<thead>
<tr>
<th>Version #</th>
<th>Date</th>
<th>Revised by</th>
<th>Changes</th>
<th>Justification</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This Standard Operating Procedure (SOP) explains the requirements for managing photographs.

Collecting GPS Data

General Tips for Using the GPS

- While recording a feature, hold the unit head-high and away from your body, so that it can “see” more sky.
- The logging interval (how often the unit records a position within a feature) has been set in the data dictionary to one second for points and five seconds for lines and polygons. This is the desired interval; however, when satellite availability is marginal the 5 seconds may be too long to collect sufficient points. In this situation, temporarily change the logging interval to 1 second
  1. While in the Data view (because you’re collecting a feature) tap “Options”
  2. Select “Logging Interval” and change the “Logging Interval” to “1s”
  3. When good satellite coverage resumes, readjust the interval to “5s”
- We recommend recording at least 15 positions for points and enough positions for lines and polygons to delineate the shape (more around corners and curves, fewer for straight sections).
- For the integrity of the data, it is a good idea to begin a new rover file every few hours rather than using the same one all day. Also, make sure each event (different location, different crew, etc) is in a separate rover file.
Remember that you can always press “Pause” to stop the recording of positions temporarily while the feature is still open. This is helpful if you have to maneuver around an object, but you do not want to map your deviation.

Stopping and resuming a feature. If you are mapping a large area with multiple common species (such as a long road) and suddenly stumble upon an unusual species, you should map the unusual species more accurately then lumping it into the larger polygon. In this case, stop the existing feature, map the specific feature, then resume the original feature.

- If the new feature will be a point (including photo point or collection), then use the “Nest” option:
  1. Pause the feature you have been collecting.
  2. Within the data screen, select “Options” > “Nest” > and select appropriate feature type.
  3. Record the new feature.
  4. When you are complete and hit OK, you will return to the feature that you originally paused.

- If the new feature will be a line or polygon, then stop, map the new one, and resume:
  1. In TerraSync, stop the current feature by clicking “OK.”
  2. Map the new feature.
  3. To resume the original feature, in the menu where you usually pick the feature type, switch “Collect” to “Update Features.”
  4. Select the feature you want to resume. It is probably the second closest distance, and you will be able to see the comment along the bottom of the screen.
  5. Click “Begin” followed by “Log.”
  6. Select “Continue Feature (Append)” to continue adding points to the original feature.
  7. End the feature like normal.
  8. To collect a new feature, you will need to change “Update” back to “Collect.”
  9. You will only be able to update recent features, so do not map multiple new features and plan to return to the original feature.

Turn on/off sounds when collecting positions
- On the Start Menu tap on “Settings”
- On the “Personal” tab, select “Sounds and Notifications”
- On the “Volume” tab, check “Programs” and “Notifications” and adjust the volume bar.

Offset feature. In general, you should map the boundaries with buffer as exactly as possible; however, sometimes you will be unable to map an edge because of satellite coverage (e.g., under trees, next to a building) or physical barriers (e.g. river, fallen trees). In these cases, you can map a set distance from the target and set the offset and direction. The offset applies to the whole feature, so plan ahead!

- With the feature already open, select “Offset” from the “Options” menu.
- For a line or polygon, the direction is the direction the target is from you as you walk the segment. The horizontal distance is the distance that you are from the target edge.

For a point, you have 5 options: Distance-Bearing, Distance-Distance, Triple Distance, Bearing-Bearing, Triple Bearing. See this [QuickStart](#) file for more information.

**Campsite Data Dictionaries**
Two data dictionaries have been developed for mapping and monitoring campsites at KEFJ: 1) Rapid Assessment and 2) Full Assessment.

**Full Campsite Assessment**

The Full Assessment data dictionary has 5 feature classes:..

1) Campsites – A point feature.
2) Photopoints – A point feature.
3) Survey_Area – A polygon feature.
4) Other_Visitor_Sites – A point feature.
5) Trails – A line feature.
Table 3 – Description of attributes within feature Campsite.

<table>
<thead>
<tr>
<th>Region</th>
<th>Beach_Name</th>
<th>Tag_Number</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 4 – Description of attributes within feature Photopoint.

<table>
<thead>
<tr>
<th>Region</th>
<th>Beach_Name</th>
<th>Tag_Number</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 5 – Description of attributes within feature Survey_Area.

<table>
<thead>
<tr>
<th>Region</th>
<th>Beach_Name</th>
<th>Tag_Number</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 6 – Description of attributes within feature Other_Visitor_Sites.

<table>
<thead>
<tr>
<th>Region</th>
<th>Beach_Name</th>
<th>Tag_Number</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 7 – Description of attributes within feature Trails.

<table>
<thead>
<tr>
<th>Region</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Beach_Name</td>
<td></td>
</tr>
<tr>
<td>Tag_Number</td>
<td></td>
</tr>
</tbody>
</table>
Re-assessments

When conducting assessments of previously mapped sites.....

Loading Data Files

All previous year’s data can be uploaded for use on the GPS units. Once transferred to your GPS unit using PFO, the data files can be used in one of two ways

Data file as background

As a background, the campsite center points and other features are visible on the “Map” screen, and you can collect features in a rover file, but the attribute information of the data file is not accessible. You can load multiple background files, which would allow a background image previously mapped features.

- Within TerraSync, select “Map” screen. From the “Layers” menu, select “Background Files.” Make sure the “Show Data Files” is selected. Select the data file(s) to display.
- The polygons are now loaded as a background image.
- None of the attribute information is accessible, but you can navigate to the polygons and collect features in a rover file.

Data file as existing data file

When the data file is loaded as an “Existing Data File”, the polygons are visible on the “Map” screen, and you can view the attribute information, but you can not collect new features or open other rover files.

- Within TerraSync, select “Data” and “Existing.”
- Highlight the appropriate data file and select the “Open” button.
- The data file is now open like a rover file, but you should not collect new features.
- Under “Options” in either “Data” or “Map,” you can “Filter” the data. For example, you could filter by park or by management action. The filtered polygons will display as green.
- From the “Data” screen you can see the distance to the nearest polygons.
- Any polygon’s attributes can be opened by highlighting it in the “Data” screen and selecting “Begin.” From the “Map” screen, you can select a polygon using the “Select” arrow from the upper left menu. This will display the summary labels. By selecting “Update Selected Feature” from the “Options” menu, you can then see all of the polygon’s attributes. Do not log positions since this would change the data!!!
- To collect new features, you must return to the “Data” screen, “Close” the data file, and reopen a rover file or begin a new rover file.

Navigating to Previously Recorded Campsites

Particularly when revisiting previously documented sites, it is important to be able to relocate a site. Using the “Map” screen is generally much easier than using the “Navigation” screen.

Using Map screen

With a data file loaded as either a background or existing data file, you will see the polygons relative to your position. As you walk, your trail will display, and you will be able to modify your path to get to
your target. If this is not enough, you can set “Nav Start” and “Nav Target” through the “Options” menu. “Nav Start” should be “GPS,” which is your current position (a single flag will appear). Click on the screen where you want to go and then select “Nav Target” as “Map Point” (two crossed flags will appear). The blue line connecting these two locations is the direct path. Under “Options”, selecting “Cross-Track Light Bar” will display a bar at the top of a map that will indicate the relative direction you need to go to get to the target.

Alternatively, you can set the “Nav Target” to the polygon desired if the data file has been opened in the Data screen. By selecting the polygon, under “Options” you can then set the target as either the “Start/End” or generally better the “Centroid.”

**Using Navigation screen**

Set the “Nav Start” and “Nav Target” as described above. The “Navigation” screen will display a number of variables of your position relative to the target, including distance, heading, bearing, etc. that are selectable by you. The cross-track bar will display on the top as well to show relative direction of travel needed. The central circle also shows the desired path. Holding the GPS in front of you, the arrow within the circle points in the desired direction. You need to be moving for the GPS to provide directional information.

**Rapid Campsite Assessment**
This Standard Operating Procedure (SOP) explains the requirements for managing photographs.

All GPS data that you collect this summer will be processed using Pathfinder Office (PFO) software, Trimble’s desktop data management software. At the beginning of the season, make sure the software is updated and that it will continually update by selecting the option in the help menu (Fig. 4). Depending on your park’s computer settings, you may not be able to automatically update software. Talk to your local IT staff for assistance.
Setting up a Project

1. Open GPS Pathfinder Office (PFO).
2. The first time you download GPS files for the season, create a new project for your park by selecting “New”
3. Give the “Project Name” the title “2009_KEFJ_CoastalCampsite” and browse to the …\Data\2009 folder for the “Project Folder.”
4. Select “OK”
5. Click “Yes” when it asks, “Folder already exists Do you want to continue?”
6. Creating the new project creates 3 new folders within …\Data\2009 – Backup, Base, and Export.
7. In Explorer, create one more folder (Final_Edits) within the project folder.
8. For the rest of the season, select the project name from the drop down menu that appears in the “Select Project” screen.

Transferring Rover Files
1. Transfer your rover files (.ssf) from the GPS unit to this folder as soon as possible after data collection.
2. In PFO, select “Utilities” > “Data Transfer”

3. Make sure the device is “GIS Datalogger on Windows CE”
4. The GPS should connect (status in upper right) automatically or when you click the button with the green circle with check mark.
5. Click “Add” and “Data File”
6. Select all the files needing to be transferred.
7. Click “Transfer All.”
8. Back up your rover files immediately in the project Backup folder.

Differentially Correcting Rover Files

1. In PFO, select “Differential Correction” from “Utilities.”
2. Add the file that needs to be corrected. To get the quality control values for the rover log spreadsheet, you need to process files individually.
3. Verify the differential correction settings.
4. Select a base station. Generally, you want to select the closest base station to where the data was collected. Sometimes you may have to select a different base station. Update the base provider list periodically by selecting “Update List.”

5. Do not change any of the base station information or reference positions.
6. Correct files by clicking “Start”
7. Assuming good differential correction (ideally over 90%), fill out rover file status log using values that appear at the end of differential correction or that are saved in a text file in the project folder.
8. Back up your .cor files immediately by copying them into the project Backup folder.
Editing Files

In order to ensure high data quality, review and edit every rover file within a few days of the data collection.

1. Copy your corrected files from the project folder into the “Final_Edits” folder and add the prefix “edited_” to each file name. For example, R051015A.cor becomes edited_R051015A.cor. Copying and renaming the file before editing ensures that you do not overwrite the original corrected file when you begin editing.

2. Check the validity of positions, once differentially corrected, to make sure they match what you recorded in the field. Using a background image will help with this.

3. For point features, click “Delete” in the Feature Properties window to see that the positions are reasonable. The “Delete” does not delete your positions but it gets rid of the feature grouping the positions. Points should have all of their positions clustered together. You may need to delete whacky points (using the “Delete” in the “Position Properties” window), such as points more than a few meters from the center of a point. Once the feature looks good, you should click “Undelete” in the “Feature Properties” window to regroup the positions.

4. For a line or polygon, you will need to delete positions that double back or cause loops in the feature. Generally the positions with the highest value in “Horiz. Precision” should be deleted since they have the most likely error.

5. Document position deletions in the rover log.

6. If a feature was recorded as the wrong type (e.g. line collected as point), follow this protocol for correcting or contact Joel Cusick for assistance.

7. Review the attributes attached to each features to check that the information is accurate and complete.

8. Elaborate on location descriptions or comments and eliminate any bad data. If you wrote in shorthand only understandable by you, now is the time to convert it to complete thoughts! Your comments will be viewable by the public, so make them understandable and appropriate for ALL AUDIENCES.

9. Take the necessary time to make your data as finished as possible. These files will be transformed into GIS data at the end of the season for anyone to peruse. Did you leave any fields blank? Are all the attributes correct?

10. In the project folder, maintain a status spreadsheet park_rover_file_status_2008.xls (save the spreadsheet locally with your park code as a prefix) to keep track of which files still need to be edited. List any issues, deletions, deviations from the protocol, or field notes you had for each rover file.

11. Copy the Final_Edits files into the project Backup folder.

12. Once you have finished editing a file, you are done with it until the end of the season.

13. Once all edited files are complete, they must be transformed into GIS files.

Recommended Editing Strategy – It’s most efficient to first look at the shapes of all the features and do the necessary deletions of positions to make the shapes true to life. Do this for the entire cor file. Then start at the beginning again and quickly flip through the features looking at the attributes for any blank data fields. Populate the field if you can accurately recall what it should have been. Then start at the beginning for the last time to carefully review the attribute information, replace any shorthand, and otherwise clarify comments. This strategy works to assure the spatial and attribute data get the attention they both need.
Standard Operating Procedure (SOP): Photo Management

Version 1.0

Change History

Version numbers will be incremented by a whole number (e.g. Version 1.3 to Version 2.0) when a change is made that significantly affects requirements or procedures. Version numbers will be incremented by decimals (e.g. Version 1.6 to Version 1.7) when there are minor modifications that do not affect requirements or procedures.

The following revisions have occurred to this plan since Month Year

<table>
<thead>
<tr>
<th>Version #</th>
<th>Date</th>
<th>Revised by</th>
<th>Changes</th>
<th>Justification</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This Standard Operating Procedure (SOP) explains the requirements for managing photographs.

Taking Photos

Use the GPS “Photo_pt” feature that will later be coupled with GPS-Photo Link to bring the photo together with the position and attribute information.

Before taking photos:
- Set the camera’s clock to be as close to the GPS clock as possible (8 hours less than UTC time during AK daylight savings). Recheck at least monthly!!!
- Resolution should be as high as reasonable given memory constraints, with the preferred filesize (for a .jpg) being greater than 1 MB per photo.
- **Before** you take your first picture of the day, take a picture of your GPS screen showing the time with seconds. This is **critical** for the GPS-Photo Link software. Within TerraSync Status>UTC Time (Fig. 6)

Figure 6 – Screen shot of GeoXT showing UTC time with seconds. Alaska daylight savings time is 8 hours less. This screen is essential for linking to the photo time for
has the time. Verify the image is legible. Several photos are better than one that is unclear. Be aware that the screen is very reflective and not easy to take a good picture of clearly. Holding the GPS at an arms length or using the macro (flower) setting when the GPS is closer may also improve the focus.

When taking photos:
- **Before** you take the photo, collect a “Photo Pt” feature using your Trimble unit at the spot where you are standing when taking the photo.
- **After** the Photo Pt is collected, then take your photo(s) of the same scene. If the subject of the photo changes such that your description is no longer valid or your position changes, you need to record a new Photo Pt before taking the next photo.

**Managing Photos**

Manage your photos – meaning upload, organize, and delete useless photos – at the same time that you are editing your spatial data in Pathfinder Office.

- Maintain subfolders by event, such as 20080613_AialikBay, that will help you locate a photo.
- Step through the “Photo Pt” features in Pathfinder Office with an image browser window open at the same time and ensure that the attribute information is complete. If incomplete, modify the attributes to be accurate. Ensure that the image name is in the Filename field.
- Delete any photos that are unusable – blurry, too dark/light, etc.
- If there are images that do not have Photo Pt features, modify the filename by putting a “z” at the beginning of the filename to flag us not to link it to a position.
- Always keep the original, unmodified, unedited images. DO NOT rotate, resize, brighten, or darken any original photo since you risk losing all data collection time embedded in the photo. If you want to edit an image, resave it with another name, such as [original filename]_edited.
- Process all the photos using GPS-PhotoLink and the data collected with your Trimble, such as the example (Fig. 7)
Figure 7 – How an image taken after a Photo_Pt can be combined in GPS-Photo Link to incorporate the position and field comment. A shapefile is also generated that contains the additional attribute information.